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Chapter 2
GUIDED TOUR

Readiris is a state-of-the-art OCR package equipped with numerous advanced
features. We will discuss all major features in this chapter and add many tips and
hints concerning the use of Readiris.

STARTING THE SOFTWARE UP

Click on the Readiris application in the submenu "I.R.I.S. Applications -
Readiris", or click on the shortcut to the Readiris application on your desktop.

The Readiris startup screen and application window are displayed. The startup
screen displays the version and copyrights of the Readiris software. Clicking the
mouse anywhere makes this screen disappear.
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THE FIRST-TIME STARTTUP

Depending on the software bundle you acquired, the first startup may be spe-
cial: you may be prompted to register your licence.

If this is the case, the use of Readiris is limited to 30 days, and by registering,
you receive a free softkey from I.R.I.S. to continue using the software after the
first month.

It takes your identification number to generate the softkey; be sure that this
number is available or mentioned when you register your licence.
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DISCOVERING THE READIRIS INTERFACE

The Readiris application window not only contains command menus but
also two button bars that give quick access to all frequent commands. Initially,
some command menus are dimmed: they concern the preview. As long as no
image is opened, they are unavailable.
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The same goes for the image toolbar on the right side of the application
window: it contains all commands you need during the image preview. The main
toolbar on the left gives quick access to all frequent general commands.

To learn which command corresponds to a certain button, hold your mouse
pointer over it for a while: a tooltip will tell what the button does.
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Finally, the window pane or image zone is where the scanned images are
displayed. You can drop image files onto the image zone to recognize them.

GETTING STARTED WITH A FIRST TUTORIAL

The best way to become familiar with the operation of Readiris is undoubt-
edly by using it. A number of prescanned images is provided with the software;
they allow you to get started even when there is no scanner connected to your
computer. Let’s turn to these now.

The "Source" button on the main toolbar determines whether you are going
to use a scanner or a prescanned image as image source. Readiris allows you to
open TIFF images (uncompressed, packbits, Group 3 and Group 4 compressed),
Paintbrush (PCX) images and Windows bitmaps (BMP). Only black-and-white
images are supported. This capability is particularly useful to convert your faxes
into editable text files.

As we are going to open a prescanned image, you should select the disk, and
not the scanner, as image source with the "Source" button.

      

Next, click the "Scan" button. You could also select the command "Open"
from the "File" menu and open a prescanned image directly - this works even if
your scanner operates as current image source.

      

You are invited to select an image file. Select the file ENGLISH.TIF in the
Readiris folder. The image is read from disk and displayed in the image zone
progressively.
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A third way of opening prescanned images is the use of “drag and drop”.
Drag an image from the Windows Explorer onto the Readiris image zone and it
is opened promptly.

The image toolbar on the right side of the Readiris application window con-
tains all commands you need during the image preview: tools to indicate the
zones of interest, to rotate the image, zoom in and out etc.
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ZOOMING IN ON IMAGES

Readiris has several commands that allow you to zoom in on the scanned
image, for instance to verify the scanning quality.

The image toolbar contains buttons that allow you to zoom in at real size, to
fit the image to the page width and to fit the entire image in the preview window.
The "View" menu contains the same commands and adds two extra zoom levels:
you can display the image at 50% and 200% of its actual size. At actual size, a
screen pixel corresponds to an image pixel. (Shortcuts are available for all zoom
levels!)

                

Finally, you can right-click the mouse button over a region of the scanned
image to zoom in at real size immediately. Right-click a second time to zoom out
again.
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ONE, DECOMPOSING A SCANNED IMAGE

Now that the image is scanned, you have to indicate which parts you want to
convert into editable text by drawing frames, so-called “windows”, around the
zones of interest.

Actually, Readiris will do this for you automatically when the option "Page
Analysis" is enabled on the main toolbar.

         

Automatic page decomposition is particularly useful when columnized texts
and documents with a complex page layout are recognized.
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Page analyisis is fast, skew-tolerant and highly accurate: it traces complex,
“irregular” shapes and ignores the graphic zones containing photo's, illustrations
etc. on the page.

However, the page analysis will detect zones where you get white text on a
black background. Recognizing such inserts is no problem: while the preview
displays the scanned document correctly on-screen, Readiris “inverts” the image
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when the need arises to recognize such text blocks! (You can have your scanner
generate full inverted images to process pages with white text on a black back-
ground. See below.)

The number of windows is indicated at all times in the tooltips of the "Text
Window" and "Graphic Window" tools.

         

Readiris not only detects the text blocks, but also sorts them: the zones are
sorted top-down, left to right by default to cope with columnized documents.
Evidently, you can modify the sort order. To do so, click the "Sort" button on
the main toolbar and click inside the windows to include them. Windows you do
not click on are simply ignored, excluded from recognition.

Page analysis is enabled by default. To force Readiris to decompose the cur-
rent page - because you disabled page analysis by accident, because you erased
some windows erroneously and want to redo the page analysis etc. -, you can
simply click the button "Analyze Page" in the image toolbar.

TWO, WINDOWING A SCANNED IMAGE MANUALLY

Page analysis is the automatic way of windowing a scanned page. Alterna-
tively, you can zone an image manually with the windowing tools of Readiris.
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To create a rectangle around a text column, select the "Text Window" tool in
the image toolbar, click the cursor in the upper left corner of the window, stretch
the window by moving the mouse to the lower right corner and click again.
(Sides smaller than 1 mm are not allowed, they wouldn't even contain a single
character anyway.)

The windows are automatically sorted in the order of creation: arrows indi-
cate the sort order.

You can also frame “irregular” text blocks by drawing polygonal windows
around them. Non-rectangular windows are created by merging rectangular zones:
as soon as two rectangles (of the same type) intersect, they become a single
window automatically! In a way, you're building a house by adding one room
after the other...
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To modify, move and delete windows, you need to select them first. To do so,
select the "Window Selection" or “arrow” tool in the image toolbar and click
inside a window. Rectangular markers now appear at each corner and in the
middle of the window sides.

           

To unselect windows, click the mouse button elsewhere. To select additional
windows, hold down the Shift key while clicking on these extra windows. To
select a window and the included windows (of the other type), hold down the
Ctrl key while clicking on the main window.

Note that you can display the type, pixel coordinates and sort order of a win-
dow by pressing the Alt key while you select it!
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So much for selecting windows. To modify a text window, select it, put your
mouse cursor over a marker and drag the side to change the window size.

To move a text window, simply select it and drag it to another location.

To delete windows, select the window(s) and choose the "Cut" or "Clear"
command from the "Edit" menu. The "Cut" command cuts the window(s) to an
internal buffer, "Clear" erases the window(s) irretrievably. When you paste win-
dows, they are inserted in their original position, and you have to drag them to
their new location.

In fact, all familiar commands from the "Edit" menu apply to the windows:
you can delete, cut, copy and paste them! The "Undo" command also applies: if
you have unfortunately deleted, moved, resized etc. some windows, "Undo" will
cancel the last operation.
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Also note that shortcuts are available for all commands! Let's give an ex-
ample: to erase all existing windows, you can choose the command "Select All"
or its shortcut Ctrl+A and click the command "Clear" or its shortcut Delete. You
are now ready to recreate the necessary layout. To restore the previous layout,
you can choose "Undo" or the shortcut Alt+Backspace.

THREE, SAVING WINDOWING TEMPLATES

The resulting windowing layouts can be saved as zoning templates for fu-
ture use with the command "Save Layout" under the "File" menu and loaded into
memory with the command "Load Layout".

If you have to recognize documents with a similar layout, for instance a 50
page report where the header and footer should be excluded for obvious reasons,
a single template can be applied to zone all 50 pages.

When you load a template into memory, page analysis is disabled automati-
cally. The zoning template remains active until you re-enable page analysis on
the main toolbar.
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READIRIS TAKES YOU AROUND THE WORLD

Assuming that the windows are correctly defined, you are now almost ready
to execute the character recognition. We say “almost”, because we haven’t veri-
fied the language and document settings yet.

The language setting can be found on the main toolbar.

Click the "Language" button to modify the document language.

You can press a letter key to move to it directly: if English is currently se-
lected, and you want to select Hungarian, you can click the "H" key on your
keyboard to go directly to the Hungarian language. When several languages have
the same initial, press the letter several times to go through the options. Let's
give an example: Readiris reads Polish and Portuguese. By pressing "P" once,
you select Polish, by pressing "P" a second time, you select Portuguese, and by
pressing "P" a third time, you're back on Polish.
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Readiris is far from limited to English: up to 52 languages are supported! All
American and European languages are supported, including the Central-Euro-
pean languages, Greek, Turkish, the Cyrillic (“Russian”) and the Baltic languages.

Also note that the British and American - or should we say “international”? -
variants of the English language are distinguished.

It takes the appropriate Windows configuration to display Central-European,
Greek, Turkish, Cyrillic and Baltic characters. You may have to install the Win-
dows “service pack” "Multilanguage Support" before your Windows system is
able to cope with these languages. Select the icon "Add/Remove Programs" un-
der the "Control Panel" to find out if this Windows module is installed  on your
PC. Depending on the software bundle you acquired, the Readiris CD-ROM
may contain detailled information on how to install this Windows module.
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Selecting the proper document language is imperative. Based on the selection
of a language, the software knows which symbols to recognize. Multi-linguistic
support ensures that “exotic” characters such as ç, ß, ñ, γ and ø are recognized
correctly.

Secondly, the software extensively uses linguistic databases to validate its
results. Suppose that you have to read the word "president" where an ink stain
makes the "r" look like an "f". Looking things up in the English lexicon, Readiris
will detect autonomously that the word "president" is being read and that it doesn't
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make any sense to recognize the symbol "f". This “self-learning” technique is
of course highly dependant on the linguistic context.

Linguistics offer useful help to solve ambiguous cases such as an "O" which
might be mistaken for a '0'. Another typical example is the letter "l" and number
'1' which have an identical form in many fonts - think of texts produced on old
typewriters! The linguistic context helps to determine whether you are dealing
with "l" or '1'.

The illustration below shows various shapes of '1' and "l". The shapes on the
first line are unambiguous, the shapes on the second line are ambiguous, but
linguistics can solve them. When the context does not suffice, the user inter-
venes.

READIRIS CHANGES LANGUAGES AS NEEDED

But the buck doesn't stop here: Readiris can switch languages in the middle
of a sentence without any help from the user! When Western words pop up in
Greek and Cyrillic documents - many untranscrible proper names, brand names
etc. are written using the familiar Western symbols -, Readiris can switch to the
correct alphabet automatically. In other words, you can activate a mixed alpha-
bet of Greek or Cyrillic and Western characters.

Be sure to select "Greek-English" or the appropriate Cyrillic language setting
- for instance "Byelorussian-English". In other words: don’t try to just select
"Greek" or "Byelorussian" as document language and hope that the Western sym-
bols will come out fine!
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Here’s an example where a Russian text contains some English words - open
the image file ALPHABET.TIF if you want to try it for yourself!

The end result looks like this when opened with the wordprocessor - you may
have to select a Cyrillic font to display the Russian text correctly.
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To mix other languages, simply select the language with the most extended
character set. If you have a document where the, say, French translation is placed
alongside an English text, you have to select French as language to ensure that
the accentuated characters such as ç, é and ù get recognized correctly.

DEFINING THE DOCUMENT CHARACTERISTICS

Now that the language is set, we’ll turn to the other document characteristics.
You can fine-tune the recognition by specifying some document features: the
font type and character pitch. Let’s clarify what this means.

First of all, indicate whether you are recognizing “normal” or dot matrix
printed documents with the command "Font Type" under the "Settings" menu.
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Setting this parameter correctly is mandatory: “draft” or “9 pin” dot matrix
symbols are made up of isolated, separate dots, and highly specialized recogni-
tion routines are required to recognize them.

“Letter quality” dot matrix printing, also called “25 pin” or “NLQ” dot ma-
trix, requires the normal setting, as do the printing qualities typeset, typewrit-
ten, laser printed and inkjet printed. Obviously, "Normal" is the default value.

The character pitch can be set with the command "Character Pitch" under
the "Settings" menu.

With fixed or “monospaced” fonts, all symbols of the font have the same
width. An "i" takes up as much horizontal space on a line
as a "w", as is the case in this sentence. Think of
documents produced using a typewriter, where the carriage moves a fixed dis-
tance for each typed symbol.

A proportional pitch means that the width of a character depends on its shape.
Symbols like “m” and “w” are wider, take more horizontal space on a line than the
“thin” characters “l” or “j”. Virtually all books, magazines and newspapers are
printed in proportional pitch.
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The simplest solution is to leave this option at all times on the default value
"Auto", which means that Readiris will detect the character pitch automatically.

READIRIS GETS MORE INTELLIGENT EACH TIME!

When the document language is selected and document characteristics are
set, you can click the "Recognize" button.

The OCR progress is indicated on-screen. You can click the "Stop" button to
abort the text recognition.

At the end of the recognition, Readiris enters the interactive learning phase
when the learning is enabled with the "Learn" button on the main toolbar. Inter-
active learning is enabled by default.

      

Font training can substantially enhance the accuracy of the recognition sys-
tem. When the user tries to read distorted, defaced forms as are found in real
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documents or stylized font shapes which Readiris does not recognize optimally,
training can overcome this temporary “failure”.

User learning is also used to train the system on special symbols which
Readiris is unable to recognize, such as mathematical and scientific symbols and
dingbats. Some examples: Readiris can be trained to recognize the "π" symbol
as "pi" or the dingbat "(" as "Tel". (However, the list of recognized symbols
cannot be extended with the symbols "π"and "("!)

The recognized text is displayed progressively and the system stops on doubtful
characters, or - if you are dealing with touching characters (“ligatures”) - on
doubtful character strings. They are always presented in their context, the doubt-
ful characters are highlighted. Unrecognized characters are represented by a tilde
(the "~" symbol).

First thing you should do is verify if you activated the correct font dictionary
and dictionary mode - these are always indicated in the title of the learning win-
dow. If that is not the case, click the "Abort" button - the document image is
redisplayed with the zoning as was created - enable the right font dictionary or
dictionary mode and run the OCR again. (The operation of font dictionaries will
be discussed shortly.)
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If necessary, enter a character (or character string) for the incorrect or un-
known shape and click one of the following buttons.

Learn
You agree with the proposed solution or correct it. The program saves this

doubtful character in the font dictionary as “sure”, final. Future recognition will
no longer require your intervention, the shape is considered learnt once and for
all.

In the example above, the system stops on a soiled character, and we click
"Learn" to accept a shape which cannot be confused with other characters.

Don't Learn
You agree with the proposed solution or correct it. The difference with the

"Learn" button is that the learnt symbol gets the status “unsure” in the dictio-
nary. For future recognition, the system will propose the learnt solution but still
require a confirmation.

This button is used for symbols which might be confused with others: a de-
faced "e" which might be mistaken for a "c", a damaged "t" which closely re-
sembles an "r" etc.
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The "s" above is seriously damaged - in fact it is close to the "£" symbol -, and
you should click "Don't Learn" so as not to confuse it with the pound symbol.

Delete
The displayed form is eliminated from the output. This button is used to ig-

nore “noise” on the documents - spots, coffee stains etc. - which might get recog-
nized as points, comma’s and what have you -, and to erase any other unwanted
symbol.

Undo
You go back to correct mistakes. You can undo the nine last decisions.

Finish
The learning process is aborted but the OCR continues in automatic mode.

All decisions by the system thereafter are accepted without user validation.

Click this button when you see that the recognition is highly accurate and
does not require detailled proofreading.
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Don't confuse "Finish" with the "Abort" button: with "Abort", no output is
generated and you start all over, with "Finish", the text is created, it just isn't
proofread in detail!

THE ROLE OF FONT DICTIONARIES

The results of each training session are temporarily held in the computer’s
memory but can and should be stored in files called “dictionaries” for future use.

These font dictionaries should be loaded into memory when you want to rec-
ognize similar documents in order to make use of the extra intelligence they
contain; in this way, Readiris takes into account the intelligence stored in these
font libraries. You could say that Readiris gets more intelligence each time you
use it!

How does this work? The operation of font dictionaries is controlled by the
"Learn" menu: you have to select a dictionary with the command "Font Dictio-
nary" and determine its mode of operation.
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Font dictionaries are limited to 500 shapes, and you are recommended to
create separate dictionaries for specific applications, for instance per type of
document. For clarity, you are recommended to give meaningful names to the
font dictionaries, for instance REPORT.DUS, PALATINO.DUS etc. Dictionar-
ies have the default extension *.DUS. Training no longer has effect when the
dictionary is full: the results of the learning are no longer held in memory or
written to a dictionary.

You can set the dictionary mode inside the command "Font Dictionary" or
directly under the "Learn" menu. Three dictionary modes are available: new,
append and read.
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By selecting "New Font Dictionary", you indicate that the training results
will be saved in a new dictionary. (If you select an existing dictionary, its con-
tents will be erased.)

The append mode indicates that the training results will be saved in an exist-
ing dictionary: the recognition makes use of the extra intelligence already con-
tained in the dictionary, and you add new font shapes to it. In simple terms, this
option allows you to build up a font dictionary in several steps.

(When you enter a filename for a new dictionary and activate the “append“
mode, an empty font dictionary is created and you complete it.)

With the last option, "Read Font Dictionary", the dictionary functions in read-
only mode: you make use of the dictionary without adding new font shapes to it.

Select the new mode when a single page is recognized. To recognize many
pages of the same type - pages with the same fonts and printing quality - select
the new mode for the first page, the append mode for a few pages more and the
read mode for the rest of the document(s). When multipage documents are rec-
ognized, scanning a next page automatically puts the user dictionary in the ap-
pend mode.

Know that the tooltip of the "Learn" button indicates at all times which font
dictionary is currently active and in which mode that dictionary operates.
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When you enter the interactive learning, the dictionary and its operating mode
are indicated in the window title; you should click the "Abort" button and start
over in case they are wrong.

WHERE TO TAKE THE TEXT

The interactive training concludes the character recognition. You are prompted
to save the recognized text.
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You can create a new file and append an existing text file - that's why you
have an "Append" option. You could for instance add two scanned pages of text
to a study which you wrote yourself. If you append an existing file, be sure it isn't
currently open, because that will prevent you from writing to it!

Saving the text means more than indicating a filename for the output file. You
also select a file format and determine the appearance of the recognized text. In
short, you have to decide where you want to take the text before you launch
execution.
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The text format can't be selected in this window, as you save the text - you
have to do it with the "Format" button (or the command "Text Format" under the
"Settings" menu) - before you launch the OCR.

This command allows you to select the file format for the output text, but
don’t forget that you can copy the recognized text to the Windows clipboard, so
there is no strict need to save the reading result to an external file!

ORGANIZING THE TEXT OUTPUT

Some options allow you to influence the look of the text output.
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The text flow of the output document is directly influenced by the option
"Merge Lines into Paragraphs" as you'll find under the "Format" button.

Keep this option enabled to have Readiris detect the paragraphs: Readiris
will then apply the normal wordwrap typical of wordprocessors, otherwise, a
carriage return is added after each line and hyphenated words remain so! Para-
graph detection is enabled by default.

Let’s give an example to clear things up. When the first three lines of a col-
umn are "The new presi-", "dent waved from the balcony." and "His wife had
joined him.", the paragraph detection gives you the following result: "The new
president waved from the balcony. His wife had joined him." The hyphenated
parts of the word "president" were “reglued” and a space was added at the end of
the first sentence, thus creating naturally flowing text.

Had paragraph detection not been enabled, the original layout would have
been retained, with a carriage return added at the end of each line.

(The "Format" button contains some formatting options we haven't discussed
yet - this will be done shortly.)

RECOGNIZING MULTIPLE PAGES

When you click "Save" to save the text, the system prompts you to read an-
other page or not. (If you send the recognized text to the clipboard, you obvi-
ously won't be prompted to save the text.)
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At this stage, some brief statistics are given on the number of characters
you've just read. Select "End" to conclude the first tutorial. The scanned image is
displayed again with the zoning as created to be available for further processing,
it stays there until you scan another page.

You can now open the recognized text with your wordprocessor or text edi-
tor, import it into your desktop publishing software or any other text-based ap-
plication. You have indeed converted a paper document into an editable com-
puter file, be it 10 to 25 times faster than manual retyping! Go ahead and com-
pare it with the image you have inside your Readiris window.

Our single page tutorial ends here. But how do you save the text of the addi-
tional pages? Or in other words: how do you process documents consisting of
multiple pages?

It's actually very simple: click "Next Page" when you are prompted to read
another page. When you do so, another page will be scanned promptly if your
scanner functions as image source. Secondly, the output file and font dictionary
are put in the append mode automatically so that you can append the text and
continue the font training comfortably.

You can go on recognizing other pages: the new text is appended to the text
file each time you save after the recognition.
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SETTING UP YOUR SCANNER

Let's set our scanner up now. It is assumed that the scanner hardware and
necessary drivers are installed correctly.

If your Readiris software licence was bundled with a scanner model, this step
probably is unnecessary as your scanner may already be set up under Readiris.

Click the "Scanner" button on the main toolbar.

Click the button "Scanner Model" to determine your scanner model.

When you select the option "<Image>" as “scanner”, prescanned images func-
tion as image source at all times - you won't have even to select the disk as image
source on the main toolbar with the "Source" button.

The "Configure" button is only available when you scanner allows it. It gives
access to some advanced scanning parameters; with Twain scanners, clicking
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the "Configure" button allows you to select the Twain source. (You can also use
the command "Select Source" under the "File" menu.)

Your scanner may also come with a scanning platform such as Visioneer
PaperPort or HP Document Assistant. Depending on the software bundle you
acquired, you may find specialized manuals concerning the scanning platforms
on the Readiris CD-ROM.

Once the scanner is selected, the same window may allow you to set the
scanning resolution, the page format and orientation, brightness and contrast and
may allow you to indicate whether you are going to use the scanner's document
feeder. With Twain compliant scanners, all scanning parameters are often set
within the Twain interface.

Select a resolution of 300 dpi for normal applications, use a higher resolu-
tion of 400 dpi for small print (below 10 point) and when the document is very
degraded.

Readiris reads point sizes of 6 to 72 point (0.08 to 1" or 0.21 to 2.54 cm).
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Readiris also recognizes “drop letters”, large caps that cover several lines.
(These can of course be no bigger than 72 point!)

By enabling the option "Landscape", you indicate that the selected page ori-
entation is wide (“landscape”) instead of tall (“portrait”). The page orientation
actually applies to reduced page formats: on an A4 flatbed scanner, you can
scan, say, A5 pages (half that big) in portrait or landscape format, but you can
obviously only scan the full A4 surface in one direction!

Whenever you need to adjust the page orientation, you can use the rotation
tools on the image toolbar. (Corresponding commands are found under the "View"
menu.)
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Three rotation directions are available: to the left, to the right and upside
down. Rotation takes a few seconds as the image itself is updated, not just the
display on-screen.

Set the brightness, and, if available, the contrast. The contrast setting is
only available on some scanners. Drag the slider bar to darken or brighten the
document; the selected values are represented numerically.

Finally, the option "Invert" allows you to generate “inverted” images - acti-
vate this option to process full pages with white text on a black background.

SAVING DEFAULT SETTINGS

Set all scanning parameters correctly and click the command "Save Default
Settings" under the "File" menu to save the current settings as default settings
for future use.

Settings files contain more than the scanner settings: they also determine
whether you are going to use interactive learning, which font dictionary is used
(and its mode), which language and font type - for instance a normal, propor-
tional font - the documents have etc. In short, all operational settings of Readiris
are stored in the settings files.
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SAVING SPECIFIC SETTINGS

The default settings will obviously be used at each startup, but you can save
specific settings as well to avoid having to redefine the operational parameters.
The commands "Save Settings" and "Load Settings" under the "File" menu take
care of this.

Let’s give an example: if you regularly have to OCR English documents with
a specific layout, you are recommended to create a settings file for this type of
document. You would then select "English" as the document language, load a
specific zoning template to avoid having to reapply the same windowing each
time, disable learning but activate a font dictionary in the “read” mode because
the same typefaces are used systematically etc.

If you are unsure what the current settings are, you don’t have to “plunge”
into every menu and command to discover what they are. You can use the com-
mand "Info" from the "File" menu to get an overview.
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RECOGNIZING PAGES AUTOMATICALLY

Now that our scanner is set up, we want to get started capturing documents.
Don't forget to select the scanner as image source with the "Source" button!

Instead of going through the OCR step by step, we will now recognize a page
automatically. We therefore click on the "Auto" button instead of the "Scan"
button.

Automatic OCR means that a page is successively scanned, windowed by
page analysis or a zoning template and recognized without interactive learning.
All you have to do is initiate the scanning and save the recognized text, the
intermediate steps are handled by Readiris.

READIRIS RECREATES YOUR DOCUMENT LAYOUT

Automatic recognition, which renders the recognition process automatic,
should not be confused with autoformatting! “Autoformatting” means that
Readiris recreates a facsimile copy of the scanned document: the word, para-
graph and page formatting of your original document are applied.

Similar typefaces (serif and sans serif, proportional and fixed) are used as in
the source document, the point sizes and typestyles (bold, italic and underlined)
are maintained across the recognition. The tabs and the alignment (left and jus-
tified) of each text block are recreated. The placement of columns, text blocks
and graphics follows your original document. In other words, Readiris allows
you to archive a true copy of your documents, be it a editable and compact text
file instead of a scanned image!
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All this implies that the sorting of windows does not apply when
“autoformatting” is used: any sorting you may have done on the results of the
page analysis is simply ignored!

Here’s an example of how it works. To get acquainted with this feature, open
the image AUTOFORM.TIF which is found in your Readiris folder.

Click the "Format" button on the main toolbar and select "RTF" (Rich Text
Format) as output format and "Recreate Source Document" as layout option. (It's
up to you whether or not you enable the option "Merge Lines into Paragraphs" to
activate wordwrap within the paragraphs.)



2 - 41

USER'S GUIDE

Note that layout reconstruction is limited to the RTF format. Other, “poor”
formats generating “plain” text such as ASCII, ANSI etc. do not support ad-
vanced formatting codes and therefore cannot offer autoformatting.

On the plus side, RTF is a widely used text format that can be opened by any
popular wordprocessor. (Know that WordPad is a “reduced” text editor, not a
fully featured wordprocessor; WordPad may open RTF files but ignores most
formatting elements such as text blocks, alignment etc.)

When the recognized text is opened using a wordprocessor, the text looks
like this without any intervention by the user. To see the effect correctly, you
need to enable the “WYSIWIG” mode of your wordprocessor, mostly called
“page layout” mode.
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In short, Readiris not only recognizes your texts, but can format them for you
as well. OCR isn't just text recognition anymore, it is becoming more and more
page or document recognition as well!
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TEXT FORMATTING, PART 2

The other layout options are "Create Body Text" and "Retain Word and Para-
graph Formatting".

As the icon on the right side illustrate, creating body text means you create a
non-formatted, “running” text. The text will be captured, but its formatting is
entirely ignored. Use this option when you just need to recapture a text but not
its layout.

The option "Retain Word and Paragraph Formatting" represents the middle
road: the word formatting - font type (serif - sans serif, proportional - fixed),
point size and typestyle (bold, italic and underlined) - is retained across the rec-
ognition, and so is the paragraph formatting - the tabs and the alignment (left
- justified).

Don't confuse this formatting option with “full” autoformatting: this option
just puts one paragraph after the other, it does not recreate columns or copy the
relative position of the various text blocks. Nor will it include the graphics as
full autoformatting can do.
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PLACING THE GRAPHICS INSIDE THE TEXT

In our example, the graphic was not included in the recognized text: we got
an empty space where the illustration used to be. That's normal, as graphics don't
contain any text, page analysis ignores them. Still, we want to create a facsimile
reproduction of our original document, so we'll repeat the OCR, only this time
with the graphic included.

To do so, draw a graphic window around the cartoon. This is done in the same
way as drawing text windows, simply select the "Graphic Window" tool now.

As the tooltip of the graphic window tools will tell us, we have one graphic
window on-screen.

You can also press the Alt key while you select a window to display its type
and its coordinates. (Contrary to text windows, graphic windows have no sort
order.)
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Repeat the recognition with the formatting option "Recreate Source Docu-
ment" selected. When you re-open the recognized text, you will see that the
black-and-white graphic is included.



2 - 46

SAVING GRAPHICS SEPARATELY

Saving graphics inside the text is only possible with “full” autoformatting -
this implies the RTF text format and the layout option "Recreate Source Docu-
ment" -, not with “poor” text formats such as ASCII, ANSI etc. Still, with Readiris,
you can save graphics without performing text recognition.

As the OCR software Readiris generates black-and-white images, no
greyscale or color images, it doesn’t make any sense to scan photographs with
Readiris, but you can capture lineart graphics effortlessly.

How? Draw a graphic zone around the illustrations, cartoons etc. you need.
Next, choose the command "Save Graphics" under the "File" menu.

You are prompted to specify a filename. Determine which graphic file format
you will use. Select a format that's supported by your paint or photo retouching
software. The TIFF and Paintbrush (PCX) formats are available. (Paintbrush
files can always be opened with the Windows accessory Paint.)
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The graphics are saved in a single file. You don't have to limit yourself to a
single graphic, but if you draw several graphic windows, they will be collected,
“stacked” in a single file. (You can use the "Crop" command of your paint or
photo retouching program to separate them.)

Sides smaller than 1 mm are not allowed - bitmaps of that size hardly contain
any information. “Irregular”, non-rectangular windows are invisibly converted
into rectangles: Readiris covers the maximal surface based on the largest coordi-
nates. In the example below, the graphic window with the black border is com-
pleted by the shaded area.
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READING FAXES AND DEFERRED RECOGNITION

Saving images as image files opens another possibility: you can save the full
page and perform deferred OCR on it later on. That's what we did with the
prescanned images of our tutorials.

Draw a graphic window around an entire page and save the graphic in the
TIFF format.
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You can now select the disk as image source and open the image file with the
"Scan" button. (If you use the "Open" command under the "File" menu, you
don't even have to update the image source.)

Readiris opens black-and-white TIFF images (uncompressed, packbits, Group
3 and Group 4 compressed), Paintbrush (PCX) images and Windows bitmaps
(BMP). This capability is particularly useful to convert your faxes into editable
text files!

If you have any influence over your correspondents, ask them to send faxes
with the “fine” quality - those faxes have the higher resolution of 200 dpi and
will yield better OCR results.

Don't forget that you can use “drag and drop” to open images: drop an im-
age file from the Windows Explorer onto the image zone of Readiris and it is
promptly opened!
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RECOGNIZING TABLES

So far, we've recognized texts and faxes and we've saved graphics. Let's pro-
cess a table now. Take a table of figures and scan it, or open the sample image
TABLE.TIF in your Readiris folder.

Actually, the image TABLE.TIF contains two tables, and that's no coinci-
dence! How tables get processed depends on their layout.

When there are borders around the cells, the page analysis zones the entire
table and Readiris can reconstruct it. When no borders enclose the table cells,
the user has to draw windows around each column to neatly arrange the output in
table cells.

Let's give two examples, starting with the framed table. As there are borders
around each cell, the page analysis detects the table by zoning it with a single
(text) window.
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Run the recognition with the layout option "Retain Word and Paragraph For-
matting" or "Recreate Source Document" enabled and the table gets recreated by
adding Tab codes between the cells.

Open your wordprocessor to have a look at the result - you can use the com-
mand “Convert Text to Table” of your wordprocessor to round things off. (You
could obviously have included the text paragraphs in the text file as well.)
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Now the example where the table has no borders around the cells. As the
page analysis doesn't detect the table as a whole, the user draws a text window
around each table column to arrange the output neatly in corresponding cells.
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This time, you must select a table format with the "Format" button to add Tab
codes between the cells. (The “general” text formats will not do; it takes a spe-
cific format to create the rows and columns!)

As with text documents, you can create an external file that can be imported
in your spreadsheet, or copy the table to clipboard and paste it directly in your
spreadsheet.
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For optimal OCR accuracy, you should limit recognition to the numeric sym-
bols with the "Language" button. (The numeric mode is not strictly numeric, it
includes the symbols 0 to 9, +, *, /, %, , (comma), . (dot), (, ), -, =, $ and £.)

As you can only do this when the table doesn't contain any alphabetic sym-
bols - otherwise the text portions won't be recognized correctly - we can activate
the numeric mode now but couldn't do it for the first table.

The result, when opened with or pasted into your spreadsheet, looks like this:
the typical table structure with rows and columns is again recreated, and you are
immediately ready to process the data.
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THE “CONNECT” FEATURE OFFERS A DIRECT LINK

Actually, there's yet another way of recognizing tables of figures: you can do
it from within your spreadsheet!

The “Connect” feature offers a direct OCR link between your scanner and
your Windows applications. Install it and you are able to scan documents di-
rectly from within your favourite Windows applications - wordprocessor or
spreadsheet!

As there are some manual steps no installation procedure can take care of for
you, you need to check the on-line help system or the file CONNREAD.DOC in
your Readiris folder to learn how to install it - it takes a macro to use the “Con-
nect” capability from within Word, Excel and WordPerfect. (That “Read Me”
file is displayed automatically at the end of the installation program.)
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When correctly installed, the “Connect” feature adds a new command to the
menus of your application. In the examples below, the command "Scan Text" is
added to the "File" menu of Word, and the menu "Scan Table" is added to the
menu bar of Excel.



2 - 57

USER'S GUIDE

Here's how it works: Readiris may not run in the background when you launch
the “Connect” macro. Click on the new command in your application menu to
run Readiris. The “Connect” interface may ask you some questions before Readiris
will start running. Proceed as usual and quit the “Connect” interface when you
are through. The recognition results are inserted at the current cursor position.
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GETTING ON-LINE HELP

This concludes our overview of Readiris. Some last-minute information may
not be included in this manual. We thus recommend you to consult the on-line
help system for additional information on Readiris.

Go to the "Help" menu to do so. The command "Help Topics" and its shortcut
key F1 allow you to navigate through the many help topics.
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